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Chapter 1

Introduction to Plan

1.1 Introduction

1.1.1

Features include:

• Task management using the Task Editor

– Work breakdown structure with configurable WBS codes
– Tasks, summary tasks, and milestones
– Different types of time constraints
– Different types of dependencies.

• Resource management using the Resource Editor

– Resource breakdown structure
– Working- and material resource types
– Resource allocation on group level
– Resource teams

• Work time & vacation definition using the Work and Vacation Editor

• Cost management using the Cost Breakdown Structure Editor

• Earned value management

• Project scheduling using the Schedules Editor

– Schedule forward from start time or backward from finish time
– Allow or avoid resource overbooking
– PERT distribution with optimistic-, pessimistic-, and most likely estimates
– Multiple schedules with a possibility to schedule from current progress information

• Task tracking using the Task Execution View or Task Status View

8
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1.2 Definitions

1.2.1

1.2.1.1 Introduction

In project management, terms may be used in different ways in different programs or different
companies or project types. Looking at more exhaustive project management glossaries, one will
find alternative definitions for most terms.
This list defines how certain terms are used in Plan.

1.2.1.2 Terms

Account
An account is used in a Cost Breakdown Structure (CBS) to represent a place where cost from
tasks or resources can be aggregated.

ACWP
Actual Cost of Work Performed

Actual Cost of Work Performed
The actual cost (or effort) that has been performed.

Allocation
Tasks are allocated to Resources during the planning stage of the project. The actual assign-
ment is done during scheduling. Note that assignment is not guaranteed as the resource
may not be available.

Assignment

Tasks are assigned to Resources during scheduling.

BCWS
Budgeted Cost of Work Scheduled

Budgeted Cost of Work Scheduled

The cost (or effort) that should have been used in order to reach the stated progress.

BCWP
Budgeted Cost of Work Performed

Budgeted Cost of Work Performed

The cost (or effort) that has been performed.

CBS
Cost Breakdown Structure

CPI
Is the Cost Performance Index and is equal to BCWP/ACWP. When this index is below 1,
means that you are over budget. If the index is greater than 1 means that the costs are
under budget.

Cost Breakdown structure
The CBS organizes accounts into a structure to enable cost to be aggregated independent of
the WBS and RBS.

9
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Estimate
The estimate is the expected amount of effort or time needed to complete a task.

Milestone
A milestone is a task with an effort of 0.00h. It is typically used to mark a major outcome,
for example the completion of a deliverable upon customer acceptance.

PERT
Program Evaluation and Review Technique

Program Evaluation and Review Technique

The Program Evaluation and Review Technique is an enhancement to the Critical Path
Method. Task effort estimates in CPM are point estimates, while task effort estimates in
PERT are computed by weighting the Optimistic, Most Likely, and Pessimistic estimates
(O+(4*M)+P)/6.

PERT Distribution
A simplified way to calculate Expected estimate from Optimistic-, Most Likely- and Pes-
simistic estimate.

RBS
Resource Breakdown Structure

Resource Breakdown Structure
The RBS organizes resources into resource groups.

Resource
A resource can be of type Work, Material or Team. A resource must always belong to a
Resource Group.

Resource Group

A resource group is used to group similar resources.

Resource Team
A resource team is a resource that consists of a number of other resources.

SPI
Is the Schedule Performance Index and is equal to BCWP/BCWS. When this index is below
1, means that you are behind schedule. If the index is greater than 1 means that you are
ahead of the schedule.

Summary Task

A Summary Task has subordinate Sub-Tasks, and rolls up information based on the Sub-
Tasks.

Task
A Task is a unit of work. Resources are generally allocated at the Task level.

vCard
vCard is a file format standard for electronic business cards.

WBS
Work Breakdown Structure

Work Breakdown Structure
The WBS is used to break down large projects into manageable chunks to ease planning
and management.
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1.3 Context Help

1.3.1

Many functions and views have help and hints that can be displayed with the What’s This func-
tion.
You can activate it with the menu entry Help → WhatsThis or keyboard shortcut Shift-F1.

In dialogs it is activated by pressing the ? in the dialogs title bar.

1.4 Main Work Space

1.4.1

1.4.1.1 Description

The Main Work Space is normally organized with the View Selector to the left and the data view
to the right.

As usual, you will also find the Menu bar and Toolbar at the top, and the Status bar at the bottom.

Since both the View selector and the Scripts docker are dockers they can be moved to the different
border, floated or hidden. To show a hidden docker, use the Settings → Dockers menu entry.

1.4.1.2 The View Selector

The View Selector enables you to select the data view you want to display from the currently
listed views.
Views are grouped into categories for easier retrieval: Editors, Views, Execution and Reports by
default:

• Editors holds the editors that you need to define and schedule your project.

• Views holds views that are used for inspecting your project.

• Execution holds views that are especially useful during the execution of your project.

• Reports holds views for report generation.

Views can also be moved within or across categories, or added to or removed from the View
Selector.

11
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1.4.1.3 Schedule Selector

The Schedule Selector enables you to select the schedule all the views (e.g. Gantt View) shall dis-
play values from. Tasks which has not been scheduled in the selected schedule are not normally
shown in any of the views. (They are shown in editors, of course.)

1.4.1.4 Status Bar

The status bar shows messages and progress information. Most notably is the currently selected
schedule shown at the right of the status bar. Note that most of the views in the Views category
display information depending on the selected schedule, so if the project is not scheduled (Not
Scheduled), most views will be empty.

1.5 Using the Views

1.5.1

1.5.1.1 Description

The Task Editor is a view that displays task data in a tree structure. Most data in the Task Editor
can be edited in situ.

1.5.1.2 Navigation

You can navigate the tree structure using the keyboard:

+ Expand an expandable row.
- Collapse a collapsible item.
Arrow left Go to previous column in the same row.
Arrow right Go to next column in the same row.
Arrow up Go to previous row in the same column.

12



The Plan Handbook

Arrow down Go to next row in the same column.
Home Go to first row, first column.
End Go to last row, last column.
Page up Go to first visible row in the same column.
Page down Go to last visible row in the same column.

1.5.1.3 Editing data

Editable items are opened for editing by double-clicking on the item or, if using the keyboard,
pressing F2 will open the current item.

When editing an item you can navigate to the next editable item as follows:

Ctrl-Alt-Arrow left Go to the previous editable item in the
same row.

Ctrl-Alt-Arrow right Go to the next editable item in the same
row.

Ctrl-Alt-Arrow up Go to the next editable item in preceding
rows.

Ctrl-Alt-Arrow down Go to the next editable item in succeeding
rows.

1.5.1.4 Drag & drop and copy/paste

Most views support drag & drop and copy/paste. Charts and Gantt charts can be dragged to
applications that support images. Table data uses the html mime type, so can be dropped on any
applications that supports this. If the view supports moving or copying items internally e.g. the
Task Editor, items can also be moved or copied.

13
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Chapter 2

Guidelines

2.1 Creating a Project

2.1.1

A new project can be created by pressing the New Project button or selecting a project template in
the Startup View.

This will create a new project with default values defined in Settings or from values defined in the
template. The Project Settings Dialog will open to enable you to define project specific properties
like project name, manager and target times.

When you create your first project, consider creating resources in a separate file. When you
refer to this file in your project(s), you do not need to define your resources again, and you can
coordinate resource usage across projects.

See Managing Resources.

If you want to coordinate resource usage across projects, your project files must be stored in the
same directory.

A useful structure could be something like this:

Plan
!-- Resources
! !-- SharedResources.plan
!-- Taskmodules
! !-- Task modules (if any)
!-- Templates
! !-- Project templates (if any)
!-- Projects
! !-- <project 1>.plan
! !-- <project 2>.plan
! !-- etc

2.2 Managing Resources

2.2.1 Description

You can create resources for a project using the Resource Editor and Work and Vacation Editor.

14
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However, if you are going to use the same resources in many projects (which is often the case) it
is more convenient to maintain resources in a separate file. The best way to do this is to create
your resources file first and then set up Plan to always load this file when creating a new project.

If you are managing projects that use totally different resource pools you can create multiple
resource files, but one project can only refer to one resource file.

You can select the resource file to use when creating a new project.

2.3 Creating ODT Report Templates

2.3.1

2.3.1.1 Description

Open Document Text report templates are regular ODT files that can be designed using any
ODT word processor like Calligra Words or LibreOffice Writer. The technique used is to use user
field variables to hold references to the information that shall be fetched from the project. The
variables are called User Fields in Writer and can be found under Insert → Field → More Fields
→ Variables → User Fields. In Words they are called Custom Variables and can be found under
Text Editing docker → Variable → Custom.

The easiest way to create a new report template is to modify an existing one as all user fields are
defined.

2.3.1.2 User Field Variables

2.3.1.2.1 Variables

The variables are used to enable the generator to extract data from the project.

A variable can be a reference to a single data field, a reference to table data or a reference to chart
data.

2.3.1.2.1.1 Single Data Field

A single data field variable has the following format:

data group name.property = property identifier

where:

• data group name can be tr, project or schedule (see below).

• property makes the user field name unique.

• property identity identifies the property in the data group.

2.3.1.2.1.2 Table Data

A table in a report template consists of a variable to specify the data table to use.

The variable name must start with table (e.g. tableTasks) and the variable value must be the
name of the data table (e.g. tasks).

Immediately after the variable, a table must be inserted and columns filled with user field vari-
ables that specify which properties to fetch from the table specified above. These variables must
have names that start with the name of the table variable above.
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These variables have the following format:

tableTasks.property = property identifier

where:

• property makes the user field name unique.

• property identifier identifies the property in the data group.

2.3.1.2.1.3 Chart Data

A chart in a report template consists of a variable to specify the data to use in the chart.

The variable name must start with chart (e.g. chartBudgetCost) and the variable value specifies
the data group and values to populate the chart.

The variable has the following format (note the semicolons):

name = data group; values=comma separated list of data properties;

where:

• name must start with chart (e.g. chartBudgetCost)

• data group

• comma separated list of data properties identifies the properties in the data group.

E.g.:

chartBudget = project; values=bcws cost, bcwp cost, acwp cost;

2.3.1.2.2 Translated Labels

Translated labels enable us to produce general report templates that can be used in different
languages.

Variable Name Variable Value
tr.project Project
tr.manager Manager
tr.schedule Schedule
tr.bcws BCWS
tr.bcwp BCWP
tr.acwp ACWP
tr.spi SPI
tr.cpi CPI

2.3.1.2.3 Project Values

Shows values from the main project.

Variable Name Variable Value Description
project.name Name The name of the project
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project.manager Manager The name of the project
manager

project.bcwscost BCWS Cost Cost based Budgeted Cost
of Work Scheduled

project.bcwpcost BCWP Cost Cost based Budgeted Cost
of Work Performed

project.acwpcost ACWP Cost Cost based Actual Cost of
Work Performed

project.spicost SPI Cost Cost based Schedule
Performance Index

project.cpicost CPI Cost Cost based Cost
Performance Index

project.bcwseffort BCWS Effort Effort based Budgeted Cost
of Work Scheduled

project.bcwpeffort BCWP Effort Effort based Budgeted Cost
of Work Performed

project.acwpeffort ACWP Effort Effort based Actual Cost of
Work Performed

project.spieffort SPI Effort Effort based Schedule
Performance Index

project.cpieffort CPI Effort Effort based Cost
Performance Index

2.3.1.2.4 Schedule Values

Shows values from the current schedule.

Variable Name Variable Value Description
schedule.name Name The name of the schedule
schedule.state State Scheduling state
schedule.direction Name Scheduling direction
schedule.overbooking Overbooking Overbooking
schedule.distribution Distribution Distribution
schedule.plannedstart Planned Start Planned Start
schedule.plannedfinish Planned Finish Planned Finish
schedule.scheduler Scheduler Scheduler
schedule.granularity Granularity Granularity

schedule.mode Mode Scheduling mode (Auto or
Manual)

2.3.1.2.5 Tables

Supported table types:

• tasks

• taskstatus

• schedules

• projects
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To create a table, place a variable just before a table in your template file. The variable name
identifies the table and must start with table, e.g. tableTaskStatus.

The value of the variable is used to point to the data to be fetched and must be one of the sup-
ported tables listed above, e.g. taskstatus.

You then put variables inside the table cells with name and value from the table below.

Note that the schedules table supports the values described in Schedule Values above.

The projects, tasks and taskstatus tables supports the following values:

Variable Name Variable Value Description

table name.name Name The name of the task or
project

table name.wbscode WBS Code

table name.type Type Type of task

table name.responsible Responsible

table name.allocation Allocation

table name.estimatetype Estimate Type

table name.calendar Calendar

table name.estimate Estimate Most likely estimate
table name.optimistic Optimistic Optimistic ratio
table name.pessimistic Pessimistic Pessimistic ratio
table name.risk Risk Estimate uncertainty
table name.constraint Constraint Type of time constraint
table name.constraintstart Constraint Start Constraint start time
table name.constraintend Constraint End Constraint finish time
table name.runingaccount Running Account Account for running costs
table name.startupaccount Startup Account Account for startup cost

table name.startupcost Startup Cost The cost incurred at startup
of the task

table

name.shutdownaccount Shutdown Account Account for shutdown cost

table name.shutdowncost Shutdown Cost The cost incurred at
shutdown of the task

table name.description Description Task description

table name.expected Expected Calculated most likely
estimate

table name.optimistic Optimistic Calculated optimistic
estimate

table name.pessimistic Pessimistic Calculated pessimistic
estimate

table name.starttime Start Time Scheduled start time
table name.endtime End Time Scheduled finish time
table name.duration Duration Scheduled duration
table name.earlystart Early Start Earliest possible start
table name.earlyfinish Early Finish Earliest possible finish
table name.latestart Late Start Latest possible start
table name.latefinish Late Finish Latest possible finish
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table name.positivefloat Positive Float

table name.freefloat Free Float

table name.negativefloat Negative Float

table name.startfloat Start Float

table name.finishfloat Finish Float

table name.assignaments Assignments Resource assignments

table name.varianceest Variance (Est) Calculated estimate
variance

table name.variancedur Variance (Dur) Calculated duration
variance

table name.optimisticdur Optimistic (Dur) Calculated optimistic
duration

table name.pessimisticdur Pessimistic (Dur) Calculated pessimistic
duration

table name.status Status Task status as shown in
Task Status View

table name.completion % Completed Task completion
table name.plannedeffort Planned Effort Planned effort
table name.actualeffort Actual Effort Actual effort
table name.remaningeffort Remaining Effort Remaining effort
table name.plannedcost Planned Cost Planned cost
table name.actualcost Actual Cost Actual cost
table name.actualstart Actual Start Actual start

table name.started Started

table name.actualfinish Actual Finish Actual finish

table name.finished Finished

table

name.schedulingstatus Scheduling Status Scheduling status

table name.bcws BCWS Budgeted Cost of Work
Scheduled (cost based)

table name.bcwp BCWP Budgeted Cost of Work
Performed (cost based)

table name.acwp ACWP Actual Cost of Work
Performed (cost based)

table name.spi SPI Schedule Performance
Index

table name.critical Critical Task is critical
table name.criticalpath Critical Path Task is in critical path
table name.notscheduled Not Scheduled Not interesting
table

name.assignmentmissing Assignment Missing Not interesting

table

name.resourceoverbooked Resource Overbooked Not interesting

table

name.resourceunavailable Resource Unavailable Not interesting

table name.constrainterror Constraints Error Not interesting
table name.effortnotmet Effort Not Met Not interesting
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table

name.schedulingerror Scheduling Error Not interesting

table name.level Node level, Level Not interesting
table name.statusnote Status Note Note: Not implemented

table name.owner Owner Must not be used, and are
not very interesting

table name.status Status Must not be used, and are
not very interesting

table name.time Time Must not be used, and are
not very interesting

2.3.1.3 Chart

Use by placing a variable with name chartX (X=some text to make the variable name unique)
with a value project before the chart that shall be used.

The variable has this format:
Variable: Name: chartX (X=some text) Value: project; values=data;

where data is a comma separated list of values to be include in the chart.

Possible data values are:

• bcws effort Budgeted cost of work scheduled, effort based.

• bcwp effort Budgeted cost of work performed, effort based.

• acwp effort Actual cost of work performed, effort based.

• spi effort Schedule performance index, effort based.

• cpi effort Cost performance index, effort based.

• bcws cost Budgeted cost of work scheduled, cost based.

• bcwp cost Budgeted cost of work performed, cost based.

• acwp cost Actual cost of work performed, cost based.

• spi cost Schedule performance index, cost based.

• cpi cost Cost performance index, cost based.

The charts you create in your template must have the same (or more) number of columns as the
number of values you specify in your variable.

Example:

Variable name: chart1 Value: project; values=bcws cost,bcwp cost, acwp cost;

Note that you cannot mix effort- and cost-based values. If you want to show both, create two
charts.

2.3.1.3.1 Gantt

Not supported.
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Chapter 3

Views and Editors

3.1 Startup View

3.1.1

The Startup View is shown at startup and when File → New is selected.

It has 3 sections for:

• Creation of new projects. See also Creating a Project and Managing Resources

• Opening existing projects. This section gives you the possibility to open an existing project file
or one of the 10 most recent projects you have opened.

• The Help section gives you links to introductory pages, documentation and community forum.

3.2 Task Editor

3.2.1

3.2.1.1 Description

The Task Editor is used to create, edit, and delete tasks.

Tasks can be organized into a hierarchical tree structure to any depth.
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3.2.1.2 Toolbar

The toolbar provides the means to create, delete and move tasks and milestones:

Button Shortcut Description

Add Task Ctrl-I

Dropdown box to create a
task or milestone. The new
item is positioned after the
currently selected item on
the same level as the
selected item. If no item is
selected, the new item is
appended at the top level.

Ctrl-Alt-I

Add Sub-task Ctrl-Shift-I

Dropdown box to create a
sub-task or -milestone. The
new item is appended as a
child to the currently
selected item.

Ctrl-Shift-Alt-I
Delete Task Delete Deletes the selected tasks.

Indent Task Appends the selected task
as a child to the task above.

Unindent Task
Moves the selected task one
level up, inserting it after its
current parent task.

Move Up Moves the selected task up
one place.

Move Down Moves the selected task
down one place.

Note that you can also move or copy tasks using drag and drop or copy/paste.
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3.2.1.3 Editing data

Data can be edited inline as described here or by using the Task Settings Dialog.

The following columns are displayed as default:

Column Description
Name The name of the task.
Status Task status
Responsible The person responsible for this task.
Allocation List of resource allocations.

Type

The type of task or the estimate type of the
task.
The type can be set to Milestone, Effort or
Duration.
Note: If the type is Summary or Project the
type is not editable.

Calendar The calendar used when estimate type is
Duration.

Estimate

The most likely estimate. The estimate is
the expected amount of effort or time
needed to complete a task. It can be
expressed in different units: h (hours), d
(days), w (weeks) and M (months).

Optimistic Ratio

Optimistic estimate expressed as a negative
percentage of the most likely estimate. (E.g.
-20%).
This is only used if a PERT distribution is
used.

Pessimistic Ratio

Pessimistic estimate expressed as a positive
percentage of the most likely estimate. (E.g.
50%).
This is only used if a PERT distribution is
used.

Risk
Risk controls the PERT distribution used
when calculating the actual estimate for this
task.

Constraint The timing constraint type.
Constraint Start Constraint start time.
Constraint End Constraint end time.
Running Account Account for running costs.

Startup Account Account for cost incurred at startup of the
task.

Startup Cost The cost incurred at startup of the task.

Shutdown Account Account for cost incurred at shutdown of
the task.

Shutdown Cost The cost incurred at shutdown of the task.
Description Task notes.
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3.2.1.4 Task Modules Docker

Task Modules are groups of tasks that can be reused across projects.

This makes it possible to draw on past experience and to standardize similar operations.

A task module is inserted into your project by dragging it from the docker and dropping it into
your project.

A task module is a regular plan file, and is designed using Plan in the same way as designing a
regular project.

A task module, however, typically includes only tasks, estimates, and dependencies.

The project name is displayed in the docker, and the description is used as the tooltip.

A module can be opened for inspection or editing by double-clicking on the module.

The modules can be grouped by storing them in different directories. Where to search for them
is configured using the Project Settings Dialog.

Default values for new projects can be defined using the Plan Configuration Dialog.

3.2.1.5 Resources Docker

The Resources Docker offers a simple way to allocate resources to tasks by selecting the resources
you need and dragging them onto the Allocation column.

A resource can also be dropped on the Responsible column.

3.2.1.6 Allocations Docker

The Allocations Docker displays the current resource allocation for the selected task.

3.2.1.7 Configuration

Using the context menu, the view can be configured to show / hide the Project, split / unsplit
the tree view or it can be configured using the configure dialog.

The configure dialog enables you to tailor
the amount of information the view
displays to fit your needs.
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3.3 Resource Editor

3.3.1

3.3.1.1 Description

The Resource Editor is used to create, edit, and delete resources and resource groups. Resources
must belong to a resource group. At the moment sub-groups are not allowed.

Working resources must refer to a calendar that defines the working hours for the resource. Cal-
endars are created using the Work and Vacation Editor.

Material resources are by default always available. You can use a calendar to limit its availability.

Resources can be Shared or Local. A local resource is only used in the current project. A shared
resource can be shared between multiple projects and is stored in a separate file, see Managing
Resources.

3.3.1.2 Toolbar

The toolbar provides the means to create and delete resources and resource groups:

Button Shortcut Description

Add Resource Group Ctrl-I

Button to create a resource
group. The new group is
appended at the end of the
groups.

Add Resource Ctrl-Shift-I

Button to create a resource.
The new resource is
appended as a child to the
currently selected group. If
a resource is selected, the
new resource is appended
to its parent group.25
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Delete Delete
Deletes the selected
resources and/or resource
groups.

Resources can be created by dropping data from any application that supports dragging vCard
information, like KAddressBook or Evolution.

Resources can be copied or moved to a different resource group using drag-and-drop.

NOTE
When moving a resource, the resource will lose any allocations.

3.3.1.3 Editing data

Data can be edited inline as described here.
Resources can also be edited using the Resource Settings Dialog.

The following columns are displayed as default:

Column Description
Name The name of the resource or resource group.

Scope A resource can be Shared or Local. A shared
resource cannot be edited.

Type The type of resource or resource group.
Initials The initials of the resource.
Email The e-mail address of the resource.

Calendar The calendar defines when the resource is
working.

Limit (%) The maximum load that can be assigned.

Available From Defines when the resource is available to
the project.

Available Until Defines when the resource is available to
the project.

Normal Rate The cost per hour, normal hours.

Account The account where the resource cost is
accumulated.

3.3.1.4 Configuration
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Using the context menu, the view can be
configured to split/unsplit the tree view or
it can be configured using the configure
dialog.
The configure dialog enables you to tailor
the amount of information the view
displays to fit your needs.

3.4 Work and Vacation Editor

3.4.1

3.4.1.1 Description

The Work and Vacation Editor is used to create, edit, and delete calendars.

Calendars define the working hours for resources. Calendars can also be used by tasks with
estimate type Duration.

Calendars have a time zone specification so you can define working hours in the resources local
time.
A calendar consists of definitions for weekdays and dates. If the date has a definition, this defi-
nition is used. If the state of the date is Undefined, the definition for the weekday is used. If this
is also Undefined, the parent calendar is checked.

A calendar can be defined as Default and is then used by all working resources without a calendar
reference.

The toolbar provides the means to create and delete calendars:
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Button Shortcut Description

Add Calendar Ctrl-I

Button to create a calendar.
The new calendar is
appended on the same level
as the selected calendar.

Add Subcalendar Ctrl-Shift-I

Button to create child
calendar. The new calendar
is appended as a child to the
currently selected calendar.

Delete Selected Calendar Delete Deletes the selected
calendar.

3.4.1.2 Editing data

Calendar name and time zone can be edited inline as described here.
The state of days and weekdays are edited by selecting the day or days you want to edit and
open the context menu.

Selecting Work... opens the Edit Work Intervals Dialog.

3.5 Cost Breakdown Structure Editor

3.5.1

3.5.1.1 Description

The Cost Breakdown Structure Editor is used to create, edit, and delete accounts.

Accounts can be connected to by tasks and resources to accumulate costs from those tasks and
resources.
The default account accumulates costs incurred from tasks that are not connected to an account.
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3.5.1.2 Toolbar

The toolbar provides the means to create and delete accounts:

Button Shortcut Description

Add Account Ctrl-I

Button to create an account.
The new account is inserted
after the selected account. If
no account is selected, the
new account is appended at
the top level.

Add Subaccount Ctrl-Shift-I

Button to create a
sub-account. The new
account is appended as a
child to selected account.

Delete Delete Deletes the selected account.

3.5.1.3 Editing data

Data can be edited inline as described here.
The following columns are available:

Column Description
Name The name of the account.
Description The description of the account.

3.6 Task Dependency Editor (Graphical)

3.6.1

3.6.1.1 Description

The Task Dependency Editor is used to create, edit, and delete task dependencies. For conve-
nience, tasks can also be inserted, deleted or edited.

The tasks are ordered in accordance with the Work Breakdown Structure (WBS).
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The symbols for summary tasks, tasks and milestones are shown below:

As the Task and Milestone are sub-items to the Summary task, they are indented. Also, note that
the WBS code is displayed along with the name.

In the following figure, a Finish-Start dependency has been inserted to make Milestone depend on
Task.
As shown below, an item consists of three different selection areas:

Item area Select the item for editing

Start area Used for creating Finish-Start and Start-Start
dependencies

Finish area Used for creating Finish-Start and
Finish-Finish dependencies

3.6.1.2 Editing dependencies

Dependencies are created by first selecting a start- or finish area of the predecessor task, then
selecting the start- or finish area of the successor task.

This can be done using the mouse or the keyboard.

Alternatively, you can drop the predecessor’s connection area on the successor’s connection area.

To edit or delete an existing dependency, you can open a dependency by selecting it, or open its
context menu.
You can also open the context menu on a connection area which will enable you to edit all de-
pendencies connected to that area.

3.6.1.3 Toolbar

The toolbar provides the means to create and delete tasks:
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Button Shortcut Description

Add Task Ctrl-I

Dropdown box to create a
task or milestone. The new
item is positioned after the
currently selected item on
the same level as the
selected item. If no item is
selected, the new item is
appended at the top level.

Ctrl-Alt-I

Add Sub-task Ctrl-Shift-I

Dropdown box to create a
sub-task or -milestone. The
new item is appended as a
child to the currently
selected item.

Ctrl-Shift-Alt-I
Delete Task Delete Deletes the selected tasks.

3.7 Task Dependency Editor (List)

3.7.1

NOTE
This view is not shown by default. For large projects, it can impact performance severely

It can be activated using the View Selector context menu.

3.8 Schedules Editor

3.8.1

3.8.1.1 Description

The Schedule Editor is used to create, edit, calculate and delete schedules.
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The Schedule Editor has three sub-views that show the results of the scheduling.
The Result sub-view shows the values needed for PERT analysis including early start and -finish,
late start and -finish along with different types of float.

The Critical Path sub-view shows the tasks that belong to the critical path.

The Scheduling Log sub-view shows a list of messages produced during scheduling.

3.8.1.2 Toolbar

The toolbar provides the means to create, delete and calculate schedules:
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Button Shortcut Description

Add
Schedule

Ctrl-I

Button to create a resource
group. The new group is
appended at the end of the
groups.

Add
Subschedule

Ctrl-Shift-I

Button to create a
sub-schedule. The new
schedule is appended as a
child to the currently
selected schedule.

Delete Delete Deletes the selected
schedule.

Calculate

Calculates the selected
schedule.

Baseline

Baselines the selected
schedule. Prevents the
schedule from being
re-calculated or deleted.

Detach

Make the selected
sub-schedule a top schedule

3.8.1.3 Editing data

Data can be edited in-line as described here.
The following columns are displayed as default:

Column Description
Name The name of the schedule.

State The schedules state. Shows a progress bar
during scheduling.

Direction

The scheduling direction.
If the direction is Forward, the project is
scheduled starting at the project’s earliest
start time specified in the main project
dialog. If the direction is Backward, the
project is scheduled starting at the project’s
latest finish time specified in the main
project dialog.
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Overbooking

Controls resource overbooking when
scheduling.
If overbooking is allowed, a resource may
be booked (on working days) to work more
than it is available. This can happen if the
resource is allocated to multiple tasks or are
booked on other projects.
If overbooking is to be avoided, resources
will not be booked more than they are
available. On resource conflict, tasks will be
delayed until the resource is available.

Distribution

The distribution to be used during
scheduling.
If the distribution is ’None’, the estimate of
the task is used as-is during scheduling.
If the distribution is ’PERT’, the estimate (E)
used is calculated based on the entered
optimistic- (O), pessimistic-(P) and most
likely (M) estimate. The formula used for
this is:
E = (O + 4 * M + P) / 6.

Planned Start The scheduled start time.
Planned Finish The scheduled finish time.

Scheduler

The scheduler used for calculating the
project schedule.
The default built-in scheduler is the
Network Scheduler.

3.8.1.4 Configuration

Using the context menu, the view can be
configured to split/unsplit the tree view or
it can be configured using the configure
dialog.
The configure dialog enables you to tailor
the amount of information the view
displays to fit your needs.
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3.9 Project Performance View

3.9.1 Description

The Project performance view is a project management chart where can be understood the actual
situation of the project according to the Earned Value Method.

where:

• BCWS means Budgeted Cost Work Scheduled,

• BCWP means Budgeted Cost Work Performed,

• ACWP means Actual Cost Work Performed.

All these are considered as effort in hours and costs.
PI are the Performance Indexes, where:

• CPI is the Cost Performance Index,

• SPI is the Schedule Performance Index.

3.10 Task Performance View

3.10.1

On the task performance chart, we can analyze deeply each subtask or task with the same indexes
as for the project performance view.

This is really useful in a long and complicated project.

On the left window, you can choose every single sub-task as well as an entire task, then on the
right window will appear in the corresponding chart.
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where:

• BCWS means Budgeted Cost Work Scheduled,

• BCWP means Budgeted Cost Work Performed,

• ACWP means Actual Cost Work Performed.

All these are considered as effort in hours and costs.
PI are the Performance Indexes, where:

• CPI is the Cost Performance Index,

• SPI is the Schedule Performance Index.

3.11 Task Status View

3.11.1

3.11.1.1 Description

The Task Status View is used to inspect task progress information at a period, set in the configu-
ration.

The tasks are divided into groups dependent on the status of the task:
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Not Started Tasks that should have been started by
now.

Running Tasks that have been started, but not yet
finished.

Finished Tasks that were finished in this period

Next Period Tasks that are scheduled to be started in the
next period.

3.11.1.2 Editing data

Progress information can be edited in-line
as described here or by using the task
progress dialog.

The following columns are displayed as default:

Column Description
Name The name of the task.
Status Task status
% Completion Task completion

Planned Effort The amount of work planned to be used at
the end of the current period.

Actual Effort The amount of work spent.

Remaining Effort The remaining effort needed to complete
the task.

Planned Cost The planned cost at the end of the current
period.

Actual Cost The actual cost incurred.
Actual Start The actual start time of the task.
Actual Finish The actual finish time of the task.

3.11.1.3 Configuration

Using the context menu, the view can be configured to split / unsplit the tree view or it can be
configured using the configure dialog.
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The configure dialog enables you to tailor
the amount of information the view
displays to fit your needs.

3.12 Task Execution View

3.12.1

3.12.1.1 Description

The Task Execution View is used to inspect task performance information.

3.12.1.2 Data

Progress information can be edited in-line
as described here or by using the task
progress dialog.

The following columns are displayed as default:

Column Description
Name The name of the task.

38



The Plan Handbook

Status Task status
% Completed Task completion
Responsible The person responsible for this task.
Assignment The resources assigned to this task.

SPI Schedule Performance Index. (BCWP /
BCWS)

BCWS Budgeted Cost of Work Scheduled.
BCWP Budgeted Cost of Work Performed.
ACWP Actual Cost of Work Performed.
Description Task description

3.12.1.3 Configuration

Using the context menu, the view can be configured to show / hide the Project, split / unsplit
the tree view or it can be configured using the configure dialog.

The configure dialog enables you to tailor
the amount of information the view
displays to fit your needs.

3.13 Task Gantt View

3.13.1

3.13.1.1 Description

The Gantt view is used to show tasks in a timeline.
Gantt View

Gantt View

3.13.1.2 Editing data

Task description and progress can be edited using the context menu.

The following columns are displayed as default:

Column Description
Name The name of the task.
Start Time The scheduled start time.
End Time The scheduled end time.
% Completed Completion
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3.13.1.3 Configuration

Using the context menu, the view can be
configured using the configure dialog.
The configure dialog enables you to tailor
the amount of information the view
displays to fit your needs.

Configuration Dialog

Configuration Dialog

3.14 Milestone Gantt View

3.14.1

3.14.1.1 Description

The Milestone Gantt view is used to show milestones in a time line.
Gantt View

Gantt View

3.14.1.2 Editing data

Milestone description and progress can be edited using the context menu.

The following columns are displayed as default:

Column Description
WBS Code The Work Breakdown Structure code
Name The name of the milestone.
Start Time The scheduled start time.

3.14.1.3 Configuration

Using the context menu, the view can be
configured using the configure dialog.
The configure dialog enables you to tailor
the amount of information the view
displays to fit your needs.

Configuration Dialog

Configuration Dialog
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3.15 Resource Assignment Gantt View

3.15.1

3.15.1.1 Description

The Resource Assignment View displays the scheduled task-resource assignments in a table.

NOTE
This view can severely impact performance in large projects.

3.15.1.2 Data

The following columns are displayed as default:

Column Description

Name The name of the object (Resource group,
resource, task)

Total The total assignment for a resource

Dates
The total assignments for a resource per
day and the assignments for the resource
per task.

3.15.1.3 Editing data

The task description and progress can be edited using the context menu.

3.15.1.4 Configuration

Using the context menu, the view can be
configured using the configure dialog.
The configure dialog enables you to include
or exclude assignments.

Configuration Dialog

Configuration Dialog

3.16 Resource Assignment View

3.16.1

3.16.1.1 Description

The Resource Assignment Gantt View displays the scheduled task-resource assignments in a
Gantt chart.
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3.16.1.2 Data

The following columns are displayed as default:

Column Description

Name The name of the object (Resource group,
resource, task)

Type Object type
Start Time The start of the assignment
End Time The end of the assignment

3.16.1.3 Editing data

The task description and progress can be edited using the context menu.

3.16.1.4 Configuration

Using the context menu, the view can be
configured using the configure dialog.
The configure dialog enables you to select
which columns to display.

Configuration Dialog

Configuration Dialog
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Chapter 4

Reports

4.1 Reports Generator View

4.1.1

4.1.1.1 Description

The Reports Generator View is used to add and generate reports in Open Document Text (odt)
format.
The reports can be based on the supplied report templates, or you can write your own templates.

Column Description
Name A name of your choice

Report Template

Path to the report template file. You can
select one of the supplied standard
templates or you can enter the filename of a
template you provide yourself.

Report File The name of the file that will be generated.

Add

Information that can be added to the report
file name to distinguish it from previously
generated versions. This can be:
• Nothing; use the filename as is

• Number; add a sequence number to the
file name

• Date; add the current date to the file
name

4.1.1.2 Toolbar

The toolbar provides the means to add, remove and generate reports.
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Button Shortcut Description
Add Report Ctrl-I Add a new report
Remove Report Ctrl-D Remove the selected report
Generate Report Ctrl-G Generate the selected report

44



The Plan Handbook

Chapter 5

Credits and License

Documentation Copyright see the UserBase Plan page history

This documentation is licensed under the terms of the GNU Free Documentation License.
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